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Safety Instructions

Important Safety Instructions

Read all of these instructions before using your printer. Also, be 
sure to follow all warnings and instructions marked on the 
printer.

❏ Do not block or cover the openings in the printer’s cabinet. 
Do not insert objects through the slots.

❏ Take care not to spill liquid on the printer.

❏ Use only the type of power source indicated on the printer’s 
label.

❏ Connect all equipment to properly grounded power outlets. 
Avoid using outlets on the same circuit as photocopiers or air 
control systems that regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or 
automatic timers.

❏ Keep the entire computer system away from potential sources 
of electromagnetic interference, such as loudspeakers or the 
base units of cordless telephones.

❏ Do not use a damaged or frayed power cord.

❏ If you use an extension cord with the printer, make sure that 
the total ampere rating of the devices plugged into the 
extension cord does not exceed the cord’s ampere rating. Also, 
make sure that the total ampere rating of all devices plugged 
into the wall outlet does not exceed the wall outlet’s ampere 
rating.

❏ Do not attempt to service the printer yourself.
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❏ Unplug the printer and refer servicing to qualified service 
personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the 
printer; the printer has been dropped or the cabinet damaged; 
the printer does not operate normally or exhibits a distinct 
change in performance.

❏ If you plan to use the printer in Germany, the building 
installation must be protected by a 10 or 16 amp circuit 
breaker to provide adequate short-circuit protection and 
over-current protection for this printer.

Note for German-speaking users:
Bei Anschluß des Druckers an die Stromversorgung muss 
sichergestellt werden, dass die Gebäudeinstallation mit einer 10 A- 
oder 16 A-Sicherung abgesichert ist.

A Few Precautions

Take note of the following when using the printer, handling the 
ink cartridges, or choosing a location for the printer.

When using the printer

Observe the following:

❏ Do not put your hand inside the printer or touch the ink 
cartridges during printing.

❏ Do not move the print head by hand; otherwise, you may 
damage the printer.

❏ Remove your printouts from the output tray shortly after 
printing; otherwise, the output tray may warp.
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❏ Always turn the printer off using the P power button. When 
this button is pressed, the P power light flashes briefly and 
then goes out. Do not unplug the printer or turn off the power 
to the outlet until the P power light stops flashing.

❏ Before transporting the printer, make sure that the print head 
is in the home (far right) position and the ink cartridges are 
in place.

When handling the ink cartridges

Observe the following:

❏ Keep ink cartridges out of the reach of children. Do not allow 
children to drink from or otherwise handle the cartridges.

❏ Be careful when you handle the used ink cartridges, as there 
may be some ink remaining around the ink supply port. If ink 
gets on your skin, wash the area thoroughly with soap and 
water. If discomfort or vision problems remain after a 
thorough flushing, see a doctor immediately.

❏ Do not shake an ink cartridge; this can cause leakage.

❏ Install the ink cartridge immediately after you remove it from 
its package. Leaving the cartridge unpacked for a long time 
before use may result in reduced print quality.

❏ Do not use an ink cartridge beyond the date printed on the 
cartridge carton. For best results, use up the ink cartridges 
within six months of installing them.

❏ Do not dismantle the ink cartridges or try to refill them. This 
could damage the print head.

❏ After bringing an ink cartridge inside from a cold storage site, 
allow it to warm up at room temperature for at least three 
hours before using it.
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❏ Store ink cartridges in a cool, dark place.

❏ Do not touch the green IC chip on the side of the cartridge. 
This may affect normal operation and printing.

❏ In this ink cartridge, the IC chip retains a variety of cartridge 
related-information, such as the amount of ink remaining, so 
that a cartridge may be removed and reinserted freely. 
However, each time the cartridge is inserted, some ink is 
consumed because the printer automatically performs a 
reliability check.

❏ If you remove an ink cartridge for later use, protect the ink 
supply area from dirt and dust and store it in the same 
environment as the printer. Note that there is a valve in the 
ink supply port, making covers or plugs unnecessary, but care 
is needed to prevent the ink from staining items that the 
cartridge touches. Do not touch the ink cartridge ink supply 
port or surrounding area.

When choosing a place for the printer

Observe the following:

❏ Place the printer on a flat, stable surface that extends beyond 
the printer base in all directions. The printer will not operate 
properly if it is tilted or at an angle.

❏ Leave enough space in front of the printer for paper to be fully 
ejected.

❏ Avoid places subject to rapid changes in temperature and 
humidity. Also, keep the printer away from direct sunlight, 
strong light, or heat sources.

❏ Avoid places subject to shocks and vibrations.

❏ Avoid places subject to dust.
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❏ Leave enough room around the printer to allow for sufficient 
ventilation.

❏ Place the printer near a wall outlet where the plug can be 
easily unplugged.

Note for French-speaking users:
Placez l’imprimante près d’une prise de contacte où la fiche peut être 
débranchée facilement.

ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined 
that this product meets the ENERGY STAR guidelines 
for energy efficiency.

The International ENERGY STAR Office Equipment Program is 
a voluntary partnership with the computer and office equipment 
industry to promote the introduction of energy-efficient personal 
computers, monitors, printers, fax machines, copiers, and 
scanners in an effort to reduce air pollution caused by power 
generation.

Warnings, Cautions, and Notes

w Warnings
must be followed carefully to avoid bodily injury.

c Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of your 
printer.
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Printer Parts and Functions

Printer Parts and Control Panel Functions

sheet feeder

edge guides printer cover

paper support

output tray

ink cartridge clamps

print head

control panel
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Buttons

Lights

Button Function

P
power

Turns the printer on and off.

Clears the printer's memory if pressed twice while the 
power is on.

b
maintenance

Loads or ejects paper if pressed and released within 
two seconds.

Resumes printing if pressed and released after a paper 
out error.

Performs print head cleaning if pressed for 3 seconds 
when the b error light is off.

Moves the print head to the ink cartridge replacement 
position and charges ink to the printer when ink is out.

e
ink cartridge 
replacement

Moves the print head to the ink cartridge replacement 
position and charges ink to the printer.

Light Description

P
power

On when the printer is on.

Flashing when printer is receiving data, printing, 
replacing an ink cartridge, charging ink, or cleaning 
the print head.

b
error

On when the printer is out of paper. Load paper in the 
sheet feeder, then press the b maintenance button 
to resume printing.

On when the paper is jammed. Take all of the paper 
out of the feeder, then reload the paper. If the light 
continues to flash, turn off the printer and gently pull 
all of the paper out of the printer.

Flashing when the black or color ink cartridge is nearly 
empty.

On when the black or color ink cartridge is empty. 
Replace the black ink cartridge (T017) or color ink 
cartridge (T018).

Flashing when the print head moves to the ink 
cartridge replacement position. The light will flash 
faster if the color ink is out than if the black ink is out.
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Loading Special Paper, Envelopes, 
and Other Media

Loading Special Paper and Other Media

You can print on a wide variety of special media, including ink 
jet paper, photo quality glossy film, photo paper, transparencies, 
index cards, and adhesive sheets.

When loading special media distributed by EPSON, read the 
instruction sheets packed with the media first and keep the 
following points in mind. 

Note:
For more details on using special media, see “Paper Handling” in the 
online Reference Guide.

❏ Make sure that the printable side of the paper is facing up 
when loading media into the sheet feeder. See the instruction 
sheets packed with the media to determine which side is the 
printable surface. Some types of media have cut corners to 
help identify the correct loading direction, as shown in the 
illustration.

printable
side up

cut corner
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❏ Make sure that the paper stack fits under the arrow mark 
located on the inside surface of the left edge guide.

❏ See below for the loading capacities for EPSON special media.

*Take care not to print on a support sheet that is loaded under special 
media.

360 dpi Ink Jet Paper and Photo 
Quality Ink Jet Paper

Up to the arrow mark on the left 
edge guide.

Photo Quality Ink Jet Cards, Ink 
Jet Note Cards, and Ink Jet 
Greeting Cards

Up to 30 index cards.
Always place the included 
support sheet* under the cards.

Photo Quality Glossy Film One sheet at a time for best results. 
Always place a support sheet* or 
a sheet of plain paper under the 
glossy film.

Ink Jet Transparencies One sheet at a time.

Photo Quality Self Adhesive 
Sheets

One sheet at a time.

Photo Paper Up to 20 sheets of 4 × 6 inch Photo 
Paper. Always place a support 
sheet* under the stack of Photo 
Paper.
200 × 300 mm Photo Paper can 
only be loaded 1 sheet at a time.

Photo Stickers 16 and Photo 
Stickers 4

One sheet at a time.

Panoramic Photo Paper and 
Iron-On Cool Peel Transfer Paper

One sheet at a time.

Matte Paper-Heavyweight Up to 20 sheets. Always place a 
support sheet* under the stack of 
Matte Paper-Heavyweight.

Premium Glossy Photo Paper One sheet at a time.
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About special media cleaning sheets

Cleaning sheets packaged with EPSON special media should not 
be used with this printer. The cleaning function performed by 
these sheets is not necessary with this type of printer, and the 
sheets could jam in the printer.

Loading Envelopes 

When printing on envelopes, please note the following:

❏ You can load up to 10 envelopes at a time in the sheet feeder.

Note:
The folding quality and thickness of envelopes varies widely. If the 
total thickness of the stack of envelopes exceeds 10 mm, press each 
envelope in the stack flat before loading. If print quality declines 
when a stack of envelopes is loaded, load one envelope at a time.

❏ Load envelopes flap edge first with the flap side down, as 
shown in the illustration.

Available envelopes sizes are:
No.10, DL, C6, 132 mm × 220 mm
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❏ Do not use envelopes that are curled or folded. Flatten the 
envelope flaps before loading. Avoid using envelopes that are 
too thin as they may curl during printing.

❏ Select Plain Paper as the Media Type setting in the printer 
driver.
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Printing with Windows

Printer Software Introduction

The printer software which comes with your printer includes a 
printer driver and printer utilities. The printer driver lets you 
choose from a wide variety of settings to get the best results from 
your printer. The printer utilities help you check the printer and 
keep it in top operating condition.

If you encounter any problems, refer to the Problem Solver HTML 
manual for help by clicking Technical Support on the Main 
menu of the printer driver.

Getting more information

For information on using the printer driver, see “Making Changes 
to Printer Settings” on page 14.

For information on using the printer utilities, see “Using the 
Printer Utilities” in the online Reference Guide.

Note:
The specific features available in the printer software vary depending on 
the version of Windows that you are using.

Online help provides more information about the printer 
software. See “Getting Information Through Online Help” on 
page 20 for instructions on accessing help.
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Accessing the printer software

You can access the printer software from most Windows 
applications, from the Windows Start menu (Windows 98, 95, 
2000 and NT 4.0), or from the Control Panel (Windows 3.1).

When you access the printer software from a Windows 
application, the settings that you make apply only to the 
application you are using.

When you access the printer software from the Start menu, the 
settings that you make apply to all of your Windows applications.

Refer to the appropriate section below.

From Windows applications
Follow the steps below to access the printer software.

1. From the File menu, click Print or Print Setup.

2. In the dialog box that appears, click Printer, Setup, Options, 
or Properties. (Depending on your application, you may need 
to click a combination of these buttons.) The printer driver 
opens.

From the Start menu (Windows 98, 95, 2000, and NT 4.0)
Follow the steps below to access the printer software.

1. Click Start, point to Settings, then click Printers.

2. For Windows 98 and 95 users, select your printer, then click 
Properties on the File menu.

For Windows 2000 users, select your printer, then click 
Printing Preferences on the File menu.

For Windows NT 4.0 users, select your printer, then click 
Document Defaults on the File menu.

The printer driver opens.
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From the Control Panel (Windows 3.1)
Follow the steps below to access the printer software.

1. Double-click the Control Panel icon in the Main program 
group.

2. Double-click the Printer icon.

3. Select your printer in the Installed Printer list.

4. Click Setup. The printer driver opens.

Making Changes to Printer Settings

The printer driver features the following menus and settings.

Note:
The Layout menu is available for Windows 98, 95, 2000, and NT 4.0 
users.

Main: Media Type, Ink, Mode, Print Preview

Paper: Paper Size, Copies, Orientation, Printable Area

Layout: Reduce/Enlarge, Multi-Page, Watermark
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The Mode settings on the Main menu are arranged to give you 
three levels of control over the printer driver, as explained below.

Automatic When this mode is selected, the printer 
driver takes care of all detailed settings 
based on the current Media Type and Ink 
settings. To make the Ink setting, click 
Color to print in color, or Black to print in 
black-and-white or grayscale. 
Depending on the media selected in the 
Media Type list (while Automatic is 
selected), a slider appears under the 
Custom radio button that lets you choose 
from Quality or Speed settings. Select 
Quality when print quality is more 
important than speed.

PhotoEnhance This mode provides a variety of image-
correction settings that you can apply to 
your photos before printing. 
PhotoEnhance does not affect your 
original data. This mode is only available 
when printing 16-, 24-, or 32-bit color data.

Custom This mode offers ready-made settings 
designed for printing text and graphs and 
for applying a color-matching method. 
You can also create and save your own 
custom settings using the Advanced 
settings.
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In addition to making comprehensive Mode settings that affect 
overall print quality, you can also modify individual aspects of 
your printout using the Paper and Layout menus. For more 
information about the Paper and Layout menus, see your online 
Reference Guide.

Making the Media Type setting

The Media Type setting determines what other settings are 
available, so you should always make this setting first.

On the Main menu, select the Media Type setting that matches 
the media that is loaded in the printer. To find out what Media 
Type you are using, find your media in the list found under “Plain 
Paper” on page 47, and refer to the corresponding Media Type 
under which it is grouped (shown in larger type). For some media, 
there are several Media Type settings to choose from.
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Previewing your printout

Select the Print Preview check box on the Main menu when you 
wish to view a preview of your document before printing.

Note:
This feature is not available for Windows 3.1.
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When you send a print job to the printer, the Print Preview 
window opens, allowing you to make changes before printing.

The Preview dialog box contains several icon buttons which you 
can use to perform  a number of functions. See online help for 
details.

You can also manipulate the previewed document in the 
following ways:

❏ Select and preview individual pages.

❏ Reduce or enlarge the size of the preview.

❏ Select and print any or all pages.

❏ Magnify the previewed document. To do this, click View and 
then Magnify to open the Magnify window, which magnifies 
the area of the previewed document that is outlined by the 
red box. By dragging the red box, you can change which part 
of the document is magnified.
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❏ View the individual pages that comprise a poster. The Poster 
window opens automatically when you send a print job while 
Poster is selected as the Multi-Page option on the Layout 
menu. From this window, you can view the individual pages 
which make up a poster. You can also open this dialog box by 
clicking View and then Poster.

❏ Apply watermarks. The watermark that you select will be 
displayed on the previewed image. For detailed information 
on customizing watermarks, see “Printing a watermark on 
your document” in the online Reference Guide. 

❏ Specify which pages in the document you would like to print 
using the Add and Remove features. To add or remove a page, 
click the page icon in the list at the left side of the preview 
window. Then, add or remove it using the commands on the 
Print Options menu.

After you have previewed the document, click Print to print the 
document, or click Cancel to cancel printing.
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Getting Information Through Online Help

Your printer software has an extensive online help feature, which 
provides you with instructions on printing, making printer driver 
settings, and using printer utilities.

Refer to the appropriate section below.

Accessing help from your application

Open the File menu and choose Print or Print Setup. Then, click 
Printer, Setup, Options, or Properties. (Depending on your 
application, you may need to click a combination of these 
buttons.) Click Help at the bottom of the Main, Paper, Layout, or 
Utility menu for help related to the items on that menu.

For Windows 98, 95, 2000, and NT 4.0 users, you can get specific 
help related to any item on a menu by right-clicking the item and 
then clicking the What’s This? command.

Accessing help from the Windows Start menu

Click the Start button, point to Programs and Epson (for 
Windows 98 and 95) or EPSON Printers (for Windows 2000 and 
NT 4.0), then click EPSON Stylus COLOR 680 Help. The help 
contents window opens.

Accessing help from Windows 3.1

Open the EPSON program group and click the EPSON Stylus 
COLOR 680 Help icon. The help contents window opens.
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Printing with Macintosh

Printer Software Introduction

The printer software which comes with your printer includes a 
printer driver and printer utilities. The printer driver lets you 
choose from a wide variety of settings to get the best results from 
your printer. The printer utilities help you check the printer and 
keep it in top condition.

For information on using the printer driver, see “Making Changes 
to Printer Settings” on page 21.

For information on using the printer utilities, see “Using the 
Printer Utilities” in the online Reference Guide.

You can also get more information about the printer software by 
clicking the help icon in any of the dialog boxes in the printer 
driver.

Making Changes to Printer Settings

You will find the printer driver settings in the following dialog 
boxes.

❏ Print dialog box (click Print on the File menu of your 
application or click Options in the Page Setup dialog box)

❏ Page Setup dialog box (click Page Setup on the File menu of 
your application)

❏ Layout dialog box (click the  Layout icon button in the Print 
dialog box)
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❏ Background Printing dialog box (click the  Background 
Printing icon button located in the Print dialog box)

❏ Preview dialog box (click the  Preview icon button and then 
click Preview in the Print dialog box)

The Mode settings in the Print dialog box are arranged to give you 
three levels of control over the printer driver, as explained below.

The Mode settings are explained below:

Automatic When this mode is selected as the Mode 
setting in the Print dialog box, the printer 
driver takes care of all detailed settings 
based on the current Media Type and Ink 
settings. To make the Ink setting, click 
Color to print in color, or Black to print in 
black-and-white or grayscale. 
Depending on the media you choose in 
the Media Type list (while Automatic is 
selected), a slider appears to the right of 
the Mode options that lets you choose 
Quality or Speed. Select Quality when 
print quality is more important than 
speed.

PhotoEnhance This mode provides a variety of image-
correction settings that you can apply to 
your photos before printing. 
PhotoEnhance does not affect your 
original data. This mode is only available 
when printing 32-bit color data.

Custom The Custom mode offers ready-made 
settings designed for printing text and 
graphs and for applying a color-
matching method. You can also create 
and save your own custom settings using 
the Advanced settings.
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In addition to making comprehensive Mode settings that affect 
overall print quality, you can also modify individual aspects of 
your printout using the settings contained in the Page Setup and 
the Layout dialog boxes.

Making the Media Type setting

The Media Type setting determines what other settings are 
available, so you should always make this setting first.

In the Print dialog box, select the Media Type setting that matches 
the paper you loaded in the printer. To find out what media type 
you are using, find your media in the list from “Plain Paper” on 
page 47, and refer to the corresponding media type under which 
it is grouped (shown in larger type). For some media, there are 
several Media Type settings to choose from.

Previewing your printout

The Preview feature allows you to see how your document will 
look before actually printing it. Follow these steps to preview 
your document.

1. Make your printer driver settings.

2. Click the  Preview icon button in the Print dialog box. The 
Print button changes into a Preview button. 

Note:
Use the  Preview icon button to switch between the  Print, 

Preview, and Save File modes. Click the icon to select the 
mode you want. For information on the Save File mode, see “Saving 
spool data as a file” in the online Reference Guide.
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3. Click the Preview button. The Preview dialog box appears 
and displays a preview of your document.

The Preview dialog box contains six icon buttons that you can 
use to perform  various functions. See online help for more 
details.

4. If you are satisfied with the previewed image, click Print.

If you are not satisfied with the appearance of the image, click 
Cancel. The Preview and Print dialog boxes close with the 
current print settings preserved. Open the Print dialog box 
again to make additional changes to the print settings.
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Replacing Ink Cartridges

Replacing an Ink Cartridge

This printer uses ink cartridges equipped with IC chips. The IC 
chip accurately monitors the amount of ink used by each 
cartridge, so even if a cartridge is removed and later inserted 
again, all of its ink can be used. However, some ink is consumed 
each time the cartridge is inserted because the printer 
automatically checks reliability.

Refer to the appropriate section below for instructions.

Using the printer's control panel

The printer’s indicator lights will inform you when it is time to 
obtain a replacement ink cartridge and when it is time to replace 
an empty cartridge. You can also check ink levels and start the ink 
cartridge replacement procedure from your computer using the 
Status Monitor utility. See the online Reference Guide for more 
information.

This table describes the status of the lights on your printer and 
the actions you need to take.

O = on, F = flashing

Lights Action

F b Obtain a replacement black (T017) or color (T018) ink 
cartridge.

O b Replace the empty black or color ink cartridge.
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To find out which ink cartridge is empty, check EPSON Status 
Monitor 3 (for Windows 98, 95, 2000, and NT 4.0) or EPSON 
StatusMonitor (for Macintosh). You can also tell which cartridge 
is empty by checking the speed at which the b error light flashes 
when the print head moves to the ink cartridge replacement 
position. See the table below.

w Warning:
❏ Keep ink cartridges out of the reach of children. Do not allow 

children to drink from or otherwise handle the cartridges.

❏ Be careful when you handle the used ink cartridges, as there 
may be some ink around the ink supply port. If ink gets on 
your skin, wash the area thoroughly with soap and water. If 
ink gets into your eyes, flush them immediately with water. 
If discomfort or vision problems remain after a thorough 
flushing, see a doctor immediately.

Lights Action

F b Replace the black ink cartridge if the b error light 
flashes at the same speed as the power light.

F b Replace the color ink cartridge if the b error light 
flashes at twice the speed of the P power light.

O b Replace both the black and the color ink cartridges 
if this light remains on.
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c Caution:
❏ EPSON recommends the use of genuine EPSON ink 

cartridges. Other products not manufactured by EPSON 
may cause damage to your printer not covered by EPSON's 
warranties.

❏ Leave the old cartridge installed in the printer until you have 
obtained a replacement; otherwise, ink remaining in the print 
head nozzles may dry out.

❏ Do not refill the ink cartridges. The printer calculates the 
amount of ink remaining using an IC chip on the ink 
cartridge. Even if the cartridge is refilled, the amount of ink 
remaining will not be recalculated by the IC chip and the 
amount of ink available for use will not change.

Note:
❏ You cannot continue printing with one ink cartridge empty, even if 

the other cartridge still contains ink. Before printing, replace the 
empty cartridge.

❏ In addition to the ink used during document printing, ink is 
consumed during the print head cleaning operation and during the 
self-cleaning cycle which is performed when the printer is turned 
on, and during ink charging when the ink cartridge is installed in 
the printer.

For more information about ink cartridges, see “When handling 
the ink cartridges” on page 3.

To replace an ink cartridge using the e ink cartridge replacement 
button, see the online Reference Guide.

Note:
You can also view on-screen instructions for replacing an ink cartridge 
from your computer using EPSON Status Monitor. Click the How to 
button in the Status Monitor’s Printer Status window, then follow the 
on-screen instructions.
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Maintenance

Checking the Print Head Nozzles

If you find that the printed image is unexpectedly faint or dots in 
the printed image are missing, you may be able to identify the 
problem by checking the print head nozzles.

You can check the print head nozzles from your computer using 
the Nozzle Check utility in the printer software, or from the 
printer itself by using the printer’s control panel buttons. For more 
information about how to use the control panel buttons, see your 
online Reference Guide.

Using the Nozzle Check utility

Refer to the appropriate section below to use the Nozzle Check 
utility.

Note:
Do not use the Nozzle Check utility while printing is in progress; 
otherwise, your printout may be marred.

For Windows users
Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.

2. Click the Utility tab in the printer software, then click the 
Nozzle Check button.

3. Follow the on-screen instructions.
28      



For Macintosh users
Follow the steps below to use the Nozzle Check utility.

1. Access the Print or Page Setup dialog box and click the 
Utility icon button, then click the Nozzle Check button in 

the Utility dialog box.

2. Follow the on-screen instructions.

The printer prints an operation check page that includes your 
printer’s ROM version information, the ink counter code, and a 
nozzle check pattern. Below are sample printouts.

Good sample

Print head needs to be cleaned

The above sample is in black and white, but the actual test prints in color 
(CMYK).

If the nozzle check page does not print satisfactorily (for example, 
if any segment of the printed lines is missing), there is a problem 
with the printer. This could be a clogged ink nozzle or a 
misaligned print head. See the next section for details on cleaning 
the print head. For information on aligning the print head, see 
“Aligning the Print Head” on page 32.

Segments are missing
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Cleaning the Print Head

If you find that the printed image is unexpectedly faint or dots in 
the printed image are missing, you may be able to solve these 
problems by cleaning the print head, which ensures that the 
nozzles are delivering ink properly.

You can clean the print head from your computer using the Head 
Cleaning utility in the printer software, or from the printer itself 
by using the printer’s control panel buttons. For more information 
about how to use the control panel buttons, see your online 
Reference Guide.

Note:
❏ Print head cleaning uses both color and black ink. To avoid wasting 

ink, clean the print head only if print quality declines; for example, 
if the printout is blurry or the color is incorrect or missing.

❏ Use the Nozzle Check utility first to confirm that the print head 
needs to be cleaned. This saves ink.

❏ When the b error light is flashing or on, you cannot clean the print 
head. Replace the appropriate ink cartridge first.

❏ Do not start the Head Cleaning or Nozzle Check utility while 
printing is in progress; otherwise, your printout may be marred.

Using the Head Cleaning utility

Refer to the appropriate section below to use the Head Cleaning 
utility.
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For Windows users
Follow the steps below to clean the print head using the Head 
Cleaning utility.

1. Make sure that the printer is on and the b error light is off.

Note:
If the b error light is flashing, you cannot clean the print head. 
Replace the appropriate ink cartridge first.

2. Click the Utility tab in the printer software, then click the Head 
Cleaning button.

3. Follow the on-screen instructions.

For Macintosh users
Follow the steps below to clean the print head using the Head 
Cleaning utility.

1. Make sure that the printer is on and the b error light is off.

2. Access the printer software and click the Utility icon 
button in the Print or Page Setup dialog box, then click the 
Head Cleaning button.

3. Follow the on-screen instructions.

If the print quality still has not improved, one or both of your ink 
cartridges may be old or damaged and may need to be replaced. 
To replace an ink cartridge before it is empty, see “Replacing Ink 
Cartridges” in the online Reference Guide.

If print quality remains a problem after replacing the ink 
cartridges, contact your dealer.

Note:
To maintain print quality, we recommend turning on the printer for at 
least one minute every month.
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Aligning the Print Head

If you notice a misalignment of vertical lines, you may be able to 
solve this problem from your computer using the Print Head 
Alignment utility in your printer software. Refer to the 
appropriate section below.

Note:
Do not start the Print Head Alignment utility while printing is in 
progress; otherwise, your printout may be marred.

For Windows users

Follow the steps below to align the print head using the Print 
Head Alignment utility.

1. Make sure that A4 or Letter size plain paper is loaded in the 
sheet feeder.

2. Click the Utility tab in the printer software, then click the Print 
Head Alignment button.

3. Follow the on-screen instructions to align the print head.

For Macintosh users

Follow the steps below to align the print head using the Print 
Head Alignment utility.

1. Make sure that A4 or Letter size plain paper is loaded in the 
sheet feeder.

2. Access the printer software and click the Utility icon 
button in the Print or Page Setup dialog box, then click the 
Print Head Alignment button.

3. Follow the on-screen instructions to align the print head.
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Troubleshooting

Online Problem Solving (not available for 
Windows 3.1)

For Windows users

The Problem Solver HTML manual provides you with tips to help 
solve any problems you may encounter when using your printer.

If you encounter a problem, access the Problem Solver in one of 
the following ways:

❏ From the Windows Start menu.

Click Start, point to Programs and then to Epson, then click 
ESC680 Problem Solver.

❏ From Status Monitor 3

Click Technical Support in the Status Monitor 3 dialog box.

❏ From your printer driver

Click Technical Support on the Main menu of the printer 
driver.

If you cannot solve your problem using the Problem Solver, 
contact Technical Support for assistance by clicking the 
Technical Support Web Site link in the Problem Solver.
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For Macintosh users

EPSON's Technical Support Web Site provides help with 
problems that cannot be solved using the troubleshooting 
information in your printer documentation.

To access Technical Support, insert the CD in the CD-ROM drive 
and double-click the Technical Support Web Site icon in the 
EPSON window.

Correcting USB Problems

If you are having difficulty using your printer with a USB 
connection, read the information in this section.

Make sure that your computer is a Windows 98 
or Windows 2000 pre-installed model

Your computer must be a Windows 98 or Windows 2000 pre-
installed model. You may not be able to install or run the USB 
Printer Driver on a computer which is not equipped with a USB 
port or which has been upgraded from Windows 95 to 
Windows 98 or 2000.

For details about your computer, contact your dealer.

Make sure that EPSON USB Printer Devices 
appears on the Device Manager menu (for 
Windows 98 only)

If you canceled the plug-and-play driver installation before the 
procedure was complete, either the USB printer device driver or 
the printer driver may be incorrectly installed.
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Follow the steps below to check the installation and reinstall the 
drivers.

1. Turn the printer on. Plug the USB cable into the printer and 
the computer.

2. Right-click the My Computer icon on your desktop, then 
click Properties.

3. Click the Device Manager tab.

If your drivers are correctly installed, EPSON USB Printer 
Devices should appear on the Device Manager menu.

If EPSON USB Printer Devices does not appear on the Device 
Manager menu, click the plus (+) sign beside Other devices 
to view the installed devices. 
      35



If USB Printer appears under Other devices, the USB printer 
device driver is not installed correctly. If EPSON Stylus 
COLOR 680 appears, the printer driver is not installed 
correctly.

If neither USB Printer nor EPSON Stylus COLOR 680 appears 
under Other devices, click Refresh or unplug the USB cable 
from the printer, then plug it into the printer again.

4. Under Other devices, select USB Printer or EPSON Stylus 
COLOR 680 and click Remove. Then, click OK.

5. When the following dialog box appears, click OK. Then click 
OK to close the System Properties dialog box.
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6. Turn off the printer and restart your PC. Then, reinstall the 
drivers from the beginning, following the instructions in the 
Setup Guide.

Printer does not work correctly with the USB cable

If your printer does not work correctly with the USB cable, try one 
or more of these solutions:

❏ Use the USB cable (C83623✽ ) recommended in “System 
Requirements” on page 51.

❏ If you use a USB hub, connect the printer to the first tier of the 
hub, or connect the printer directly to the computer’s USB 
port.

❏ For Windows 98, try reinstalling the USB printer device 
driver and the printer software. First, uninstall EPSON Printer 
Software using the Add/Remove Programs utility in the 
Control Panel, then uninstall EPSON USB Printer Devices. 
Next, reinstall the software as described in Setup Guide. If 
EPSON USB Printer Devices is not registered in the 
Add/Remove Programs list, access the CD-ROM and double-
click epusbun.exe. in Win9x folder. Then follow the 
on-screen instructions.
      37



            
Error Indicators

You can identify many common printer problems using the lights 
on your printer’s control panel. If your printer stops working and 
the lights are on or flashing, use the following table of panel light 
patterns to diagnose the problem, then follow the recommended 
corrective measures.

Lights Problem and Solution

O b
Paper out

No paper is loaded in 
the printer.

Check EPSON Status Monitor 3 
or EPSON StatusMonitor. Load 
paper in the sheet feeder, 
then press the 
b maintenance button. The 
printer resumes printing and 
the light goes out.

O b
Paper jam

Paper has jammed in 
the printer.

Check EPSON Status Monitor 3 
or EPSON StatusMonitor. Press 
the b maintenance button to 
eject the jammed paper. If the 
error does not clear, open the 
printer cover and remove all of 
the paper inside, including any 
torn pieces. Then, reload the 
paper in the sheet feeder and 
press the b maintenance 
button to resume printing. 

F b
Ink low

The black or color ink 
cartridge is nearly 
empty.

Obtain a replacement black 
(T017) or color (T018) ink 
cartridge. To see which 
cartridge is nearly empty, 
check the ink level using 
EPSON Status Monitor 3 or 
EPSON StatusMonitor.
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O = on, N = off, F = flashing

O b
Ink out

The black or color ink 
cartridge is empty or 
not installed.

Replace the black (T017) or 
color (T018) ink cartridge with 
a new one. See “Replacing Ink 
Cartridges” on page 25 for 
details.

Wrong cartridge (black ink cartridge)

The installed black or 
color ink cartridge 
cannot be used by this 
printer.

Use the appropriate black 
(T017) or color (T018) ink 
cartridge. See “Replacing Ink 
Cartridges” on page 25 for 
details.

N P
O b

Carriage error

The print head 
carriage is obstructed 
by jammed paper or 
other foreign material 
and cannot return to 
the home position.

Turn off the printer. Open the 
printer cover and remove any 
paper from the paper path by 
hand. Then, turn the printer 
back on.

If the error does not clear, 
contact your dealer.

F P
F b

Unknown printer error

An unknown printer 
error has occurred.

Turn off the printer and 
contact your dealer.
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Typical Problems and Solutions

Most printer problems have simple solutions. Find the problem 
in the list below and apply the recommended solution. For more 
information, see “Troubleshooting” in the online Reference Guide.

Print quality problems

If you are having print quality problems, try the solutions offered 
for the problems listed below.

Horizontal banding
Try one or more of these solutions:

❏ Make sure the printable side of the paper is face up in the sheet 
feeder.

❏ Run the Nozzle Check utility. If any segments are missing in 
the nozzle check pattern, run the Head Cleaning utility to 
clear any clogged ink nozzles.

Vertical misalignment
Try one or more of these solutions:

❏ Make sure the printable side of the paper is face up in the sheet 
feeder.

❏ Run the Print Head Alignment utility.

❏ Clear the High Speed check box in the Advanced dialog box 
of your printer driver. For instructions, see the printer driver’s 
online help.
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Color gaps
Try one or more of these solutions:

❏ Make sure your paper is not damaged, dirty, or too old.

❏ Run the Head Cleaning utility to clear any clogged ink 
nozzles.

❏ Make sure there are no error messages displayed. If an error 
message indicates that the ink cartridges need replacing, click 
the How To button and follow the on-screen instructions.

Blurry or smeared printout
Try one or more of these solutions:

❏ Make sure the printable side of the paper is face up in the sheet 
feeder.

❏ Make sure your paper is not damaged, dirty, or too old.

Paper feed or paper jam problems

If the printer does not feed paper, feeds multiple pages, or the 
paper is jammed, remove and reload the stack of paper, then press 
the b maintenance button. Also make sure the following:

❏ The paper isn’t too old or creased.

❏ Paper isn’t loaded above the arrow on the left edge guide.

❏ The edge guides are set correctly.

❏ The paper isn’t too thin or rough. Use paper that meets the 
paper requirements for the printer. See the online Reference 
Guide for paper specifications.

Note:
The print quality of the first page printed after a paper jam may not be 
what you expect. If print quality is a problem, try printing the page 
again.
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Cancelling Printing

If the printouts are not what you expected and contain incorrect 
or garbled characters or images, you may need to cancel printing. 
To cancel printing, follow the instructions in the appropriate 
section below.

For Windows 98, 95, 2000, and NT 4.0 users

When you send a print job to the printer, the Progress Meter 
appears on your computer screen.

Click the Stop button to cancel printing.
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For Windows 3.1 users

When you send a print job to the printer, the Despooler appears 
on your computer screen.

Click the Stop button to cancel printing.

For Macintosh users

The procedure for canceling printing for Macintosh varies, 
depending upon whether background printing is on or off. Refer 
to the appropriate section below.

When background printing is on
Follow the steps below to cancel a print job.

1. Select EPSON Monitor3 from the application menu.

2. Press the P power button to turn off the printer.
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3. In the Document Name list, select the document which is 
printing, then click the  Stop icon button to cancel the print 
job.

When background printing is off

Follow the steps below to cancel a print job.

1. Press the P power button to turn off the printer.

2. Hold down the J command key on your keyboard and press 
the period (.) key to cancel the print job.

Using EPSON Spool Manager

EPSON Spool Manager is similar to Windows Print Manager. If 
it receives two or more print jobs at one time, it holds them in the 
order that they were received (with printers on a network this 
may be called a print queue). When a print job reaches the top of 
the line, the EPSON Spool Manager sends the job to the printer. 
From the Spool Manager, you can view print status information 
about the print jobs which have been sent to your printer. You can 
also cancel, pause and resume, or restart selected print jobs.

Note:
EPSON Spool Manager is not available for Windows 2000, 
Windows NT, or Macintosh.
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For Windows 98 and 95
After you send a print job, an EPSON Stylus COLOR 680 button 
appears on the taskbar. Click this button to open the EPSON Spool 
Manager.

For Windows 3.1
After you send a print job, the EPSON Spool Manager icon 
appears at the bottom of your desktop. Double-click this icon or 
the Spool Manager icon in the EPSON group to open EPSON 
Spool Manager. For more information, see online help.
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Options and Consumable Products

Options and Consumable Products

The following options and consumable products are available for 
your printer.

Options

EPSON supplies the following interface cables for your printer. 
However, you can use any interface cables that meet these 
specifications. See your computer manual for any additional 
requirements.

❏ Parallel Interface Cable (shielded) C83602✽  from D-SUB 25-
pin (computer) to 36-pin Amphenol 57 Series (printer)

❏ USB Interface Cable (shielded) C83623✽  from Series A4-pin 
(computer) to series B 4-pin (printer).

Note:
❏ The asterisk (✽ ) is a substitute for the last digit of the product 

number, which varies by location.

❏ Depending on your geographic location, this cable may not be 
supplied.

c Caution:
Use only interface cables which meet the specifications listed 
above. Using other cables not covered by EPSON warranties may 
cause the printer to malfunction.
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Consumable products

The following ink cartridges and EPSON special media are 
available for your printer.

Ink cartridges
You can use the following cartridges with your printer.

Note:
The product numbers of ink cartridges may vary by location.

Media types
EPSON offers specially-designed media for ink jet printers to 
meet most high-quality printing needs.

To make the Media Type setting in your printer driver, select the 
Media Type setting that matches the media that is loaded in the 
printer. To find out what media type you are using, find your 
media in the list below, and refer to the corresponding media type 
under which it is grouped (shown in larger type). For some media, 
there are several Media Type settings to choose from.

The available media types are listed below.

Plain Paper

Black ink cartridge T017

Color ink cartridge T018

Plain paper

Envelopes

EPSON Premium Ink Jet Plain Paper (A4) S041214
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360 dpi Ink Jet Paper

Photo Quality Ink Jet Paper

EPSON 360 dpi Ink Jet Paper (A4) S041059
S041025

EPSON 360 dpi Ink Jet Paper (Letter) S041060
S041028

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

EPSON Iron-On Cool Peel Transfer Paper (Letter) S041153
S041155

EPSON Photo Quality Ink Jet Paper (A4) S041061
S041026

EPSON Photo Quality Ink Jet Paper (Letter) S041062
S041029

EPSON Photo Quality Ink Jet Paper (Legal) S041067
S041048

EPSON Photo Quality Ink Jet Cards (A6) S041054

EPSON Photo Quality Ink Jet Cards (5 × 8”) S041121

EPSON Photo Quality Ink Jet Cards (8 × 10”) S041122

EPSON Photo Quality Self Adhesive Sheets (A4) S041106

EPSON Ink Jet Note Cards A6 (with envelopes) S041147

EPSON Ink Jet Greeting Cards 5 × 8” 
(with envelopes)

S041148

EPSON Ink Jet Greeting Cards 8 × 10” 
(with envelopes)

S041149
48      



Matte Paper-Heavyweight

Photo Paper

Photo Quality Glossy Film

Ink Jet Transparencies

EPSON Matte Paper-Heavyweight (A4) S041256
S041258
S041259

EPSON Matte Paper-Heavyweight (Letter) S041257

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (Letter) S041141

EPSON Photo Paper (4 × 6”) S041134

EPSON Photo Paper (100 × 150 mm) S041255

EPSON Photo Paper (200 × 300 mm) S041254

EPSON Panoramic Photo Paper (210 × 594 mm) S041145

EPSON Photo Paper Cards (A4) S041177

EPSON Photo Quality Glossy Film (A4) S041071

EPSON Photo Quality Glossy Film (Letter) S041072

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176

EPSON Ink Jet Transparencies (A4) S041063

EPSON Ink Jet Transparencies (Letter) S041064
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Premium Glossy Photo Paper

Note:
The availability of special media varies by location.

EPSON Premium Glossy Photo Paper (A4) S041287
S041297

EPSON Premium Glossy Photo Paper (Letter) S041286
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Printer Specifications

System Requirements

Using the printer

Refer to the appropriate section below for the minimum and 
recommended computer system requirements necessary to use 
this printer.

For Windows computers
To use your printer, you need Microsoft® Windows® 98, 
Windows® 95, Windows® 3.1, Windows® 2000, or Windows® 
NT 4.0 installed and the printer must be connected via a shielded, 
twisted-pair parallel cable. If you want to connect your printer to 
a USB port, you need a Windows 98 or Windows 2000 pre-
installed PC equipped with a USB port and the printer must be 
connected via a standard, shielded USB cable.
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Your computer should also meet the following system 
requirements.

Your computer dealer can help you update your system if it does 
not meet these requirements.

For Macintosh computers
To connect this printer to Apple® Macintosh® computers, you 
must use a USB cable.

Your Macintosh must also meet the following system 
requirements.

Minimum System Requirements Recommended System

i486/66 MHz for Windows 98

i486/25 MHz for Windows 95 and NT 4.0

i386/25 MHz for Windows 3.1

Pentium 133 MHz for Windows 2000

Pentium or higher processor for 
Windows 98, 95, 3.1, and NT 4.0

133 MHz or higher processor for 
Windows 2000

16 MB RAM for Windows 98, 95, 3.1, and 
NT 4.0

32 MB RAM for Windows 2000

32 MB RAM or more for 
Windows 98, 95, and 3.1

64 MB or more for 
Windows 2000 and NT 4.0

20 MB hard disk space for Windows 98, 
95, and 3.1

40 MB for Windows 2000 and NT 4.0

50 MB or more hard disk space 
for Windows 98, 95, and 3.1

100 MB or more for 
Windows 2000 and NT 4.0

VGA monitor VGA or better monitor

Minimum System Requirements Recommended System

Mac OS 8.1 Mac OS 8.5.1 or later

8 MB of available memory

8 MB of available memory when 
background printing is turned on.

19 MB or more of available 
memory

32 MB of available memory when 
background printing is turned on.
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Note:
❏ The amount of available memory varies according to the number and 

kind of applications that are open. To see how much memory is 
available, choose About This Computer from the Apple menu and 
refer to the memory size (listed in kilobytes) under “Largest Unused 
Block” (1,024K=1 MB).

❏ The memory requirements above are for printing on Letter size 
paper. These requirements may vary depending on the size of the 
paper, the type of application you are using, and the complexity of 
the document that you want to print.

In addition to these system and memory requirements, you need 
10 MB of free hard disk space to install your printer software. To 
print, you also need extra hard disk space amounting to about 
twice the size of the file that you want to print.

Using the online Reference Guide

Refer to the appropriate section below for the minimum system 
requirements necessary to use the online Reference Guide.
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For Windows computers

For Macintosh computers

System Microsoft Windows® 98, 95, 3.1, 2000 or NT 4.0

CPU i486/66 MHz (for Windows 98)

i486/25 MHz (for Windows 95 and NT 4.0)

i386/25 MHz (for Windows 3.1)
(Pentium or better recommended)

Pentium 133 MHz for Windows 2000

Memory 16 MB for Windows 98, 95, 3.1, and NT 4.0
(32 MB or more recommended)

32 MB for Windows 2000

Hard disk space 5  MB to install the Reference Guide

45 MB to install Microsoft Internet Explorer

CD-ROM drive Double-speed
(quad-speed or faster recommended)

Display 640 × 480 pixel or 800 × 600 pixel resolution, with High 
Color (16 bit) or True Color (32 bit) setting

Browser Web browser 
(Microsoft Internet Explorer 4.0 or later recommended)

System System 7.5.1 (System 7.6 or later recommended)

Memory 16 MB (32 MB or more recommended)

Hard disk space 4 MB to install the Reference Guide

15 MB to install Microsoft Internet Explorer

CD-ROM drive Double-speed
(quad-speed or faster recommended)

Display 640 × 480 pixel or 800 × 600 pixel resolution, with High 
Color (16 bit) or True Color (32 bit) setting

Browser Web browser 
(Microsoft Internet Explorer 4.0 or later recommended)
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Customer Support

Technical Support Web Site

EPSON's Technical Support Web Site provides help with 
problems that cannot be solved using the troubleshooting 
information in your printer documentation. If you have a Web 
browser and can connect to the Internet, access that site at:

http://support.epson.net/StylusCOLOR680

Regional Customer Services

If your EPSON product is not operating properly and you cannot 
solve the problem using the troubleshooting information in your 
product documentation, contact customer support services for 
assistance. If customer support for your area is not listed below, 
contact the dealer from whom you purchased your product.

Customer support will be able to help you much more quickly if 
you provide the following information.

❏ Product serial number
(The serial number label is usually on the back of the product)

❏ Product model

❏ Product software version
(Click About, Version Info, or similar button in the product 
software)

❏ Brand and model of your computer

❏ Name and version of your computer operating system

❏ Names and versions of the applications you normally use 
with your product
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For users in Australia
EPSON Australia wishes to provide you with a high level of 
customer service. In addition to your product documentation, we 
provide the following sources for obtaining information:

Your dealer

Don’t forget that your dealer can often help identify and resolve 
problems. The dealer should always be the first call for advice on 
problems, they can often solve problems quickly and easily as 
well as give advice on the next step to take.

Internet URL http://www.epson.com.au

Access the EPSON Australia World Wide Web pages. Worth 
taking your modem here for the occasional surf! The site provides 
a download area for drivers, EPSON contact points, new product 
information and technical support (e-mail).

EPSON Faxback service

EPSON Faxback service will fax you the latest specifications for 
most EPSON products offered in Australia. Phone (02) 9903 9075 
and the system will guide you through a number of choices before 
faxing the information to your fax machine.

EPSON Helpdesk

EPSON Helpdesk is provided as a final backup to make sure our 
clients have access to advice. Operators on the Helpdesk can aid 
you in installing, configuring and operating your EPSON 
product. Our Pre-sales Helpdesk staff can provide literature on 
new EPSON products and advise where the nearest dealer or 
service agent is located. Many types of queries are answered here.
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The Helpdesk numbers are:

We encourage you to have all the relevant information on hand 
when you ring. The more information you prepare, the faster we 
can help solve the problem. This information includes your 
EPSON product documentation, type of computer, operating 
system, application programs, and any information you feel is 
required.

For users in Malaysia
Contacts for information, support, and services are:

World Wide Web (www.epson.com.my)

Information on product specifications, drivers for download, 
Frequently Asked Questions (FAQ), and Email Enquiries are 
available.

Epson Trading Shah Alam Head Office

For users in Singapore
Sources of information, support, and services available from 
Epson Singapore are:

World Wide Web (www.epson.com.sg)

Information on product specifications, drivers for download, 
Frequently Asked Questions (FAQ), Sales Enquiries, and 
Technical Support via e-mail are available.

Phone: 1300 361 054

Fax: (02) 9903 9189

Phone: 03 5191366

Fax: 03 5191281
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Epson HelpDesk [phone: (065) 5863111]

Our HelpDesk team can help you with the following over the 
phone:

❏ Sales enquiries and product information

❏ Product usage questions or problem

❏ Enquiries on repair service and warranty

For users in Hong Kong
To obtain technical support as well as other after-sales services, 
users are welcome to contact EPSON Hong Kong Limited.

Internet home page

EPSON Hong Kong has established a local home page in both 
Chinese and English on the Internet to provide users with the 
following information:

❏ Product information

❏ Answers to Frequently Asked Questions (FAQs)

❏ Latest versions of EPSON product drivers

Users can access our World Wide Web home page at:

http://www.epson.com.hk

Electronic bulletin board system

An electronic bulletin board system (BBS) is also available to 
obtain product information and the latest versions of product 
drivers. You can log on to the following number for the BBS 
service:

BBS: (852) 2827-4244
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Technical support hotline

You can also contact our technical staff at the following telephone 
and fax numbers:

Phone: (852) 2585-4399

Fax: (852) 2827-4383
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